
 

PHOTOGRAPHY & VIDEO COMPETITION 

Terms & Conditions 
1. By entering the competition, you agree to these terms and conditions and comply fully with 

them. 
2. The competition is open to everyone except those directly involved and judging (including 

their families and relatives). 
3. If you are under 18, you must have permission to enter from your parent(s) or guardian(s). 

By submitting an entry for the competition, your parent/carer/guardian is deemed to have 
given such consent and to agree to the use of the entry as described in these terms and 
conditions. 

4. The closing date for submissions is 12th December 2021. All submissions received after this 
time will not be eligible. Please note that sending is not proof of receipt. 

5. A £10 fee will be charged for administration fees per entrant.   
6. Entries should be submitted according to the instructions on the page at the Chelmsford 

Fringe Festival. Any correspondence must be using the email: 
competition@chelmsfordfringefestival.com  

7. The Organisers cannot be held responsible for emails that do not arrive due to the entrant's 
email security settings or restrictions placed by their Internet service provider. 

8. Your entry must be submitted digitally via this email, and no other forms of entry will be 
accepted. 

9. By submitting images to the Chelmsford Fringe Festival, each entrant confirms and warrants 
that:  
 

a) they are the sole author of each entry and that it is their original work; 
b) they own the copyright and any other intellectual property rights of each 

image; 
c) they have the permission of anyone pictured in the image (or, where the 

image shows any persons under 18, the consent of their parent/guardian) 
for the usage rights required by the Chelmsford Fringe Festival – by using 
the form ‘Photography/Filming – Individual Consent Form’ - and will 
indemnify the Chelmsford Fringe Festival against any claims made by any 
third parties in respect of any infringement;  

d) they have not licensed or disposed of any rights in the image that would 
conflict with uses to be made by the Chelmsford Fringe Festival; 

e) they have received any necessary permissions from the owner(s) of objects, 
including buildings (venues) included in submitted images for the usage 
rights required by the Chelmsford Fringe Festival and will indemnify the 
Chelmsford Fringe Festival against any claims made by any third parties in 
respect of such infringement. 
 
 
 
 

mailto:competition@chelmsfordfringefestival.com
https://28a766f9-655b-4ee9-b748-0a7a29ecbc64.filesusr.com/ugd/cdbe2e_aaffe2c6fffe4b7788d7e18312ae0147.pdf


 

10. Photographers' rights 
The following describes a general guide to the main legal restrictions on the right to take 
photographs and publish pictures. It is not a complete or definitive guide on the law. If you 
are faced with unusual circumstances, specific issues, concerns or difficulties, we suggest 
you seek legal advice. 
 

10.1 These links give further information:  
Urban 75 Photographers rights - street shooting, people, privacy and children 
Photographers’ Rights in the UK  
British Photographic Council (BPC) 
The British Press Photographers' Association (BPPA) 
Wikipedia: Photography and the Law 
I'm a Photographer not a Terrorist 
Police National Legal Database advice page 

 
10.2 UK Law 

On the whole, UK law doesn't prevent photography in public places. The UK has relatively 
liberal laws regarding photography compared with many countries. Although there are some 
exceptions, the key principle is that you can photograph people and buildings without 
needing permission, providing you are in a public place.  

As long as you're not causing any harassment, you're allowed to photograph other people if 
they are in a public place. Public vs Private 

Many of the incidents in which photographers come into difficulty are that many places you 
instinctively think are public are privately controlled; this includes some shopping centres, 
car parks, some parks and play areas (depending on the attitude of the landowner) and 
various private structures, for example, Millennium Wheel on the South Bank in London. 
There is a trend for public places to become private, particularly in town centres developed 
with new shopping centres. 

10.3 In a public place 
 
Taking photos in a public place is not illegal. The only time an offence is committed is if the 
photographs being taken are considered to be indecent. There is no law stating that you 
can't take photographs in public; this includes taking photos that include other people's 
children or taking photos of children directly. An offence will, however, have been 
committed if the photographs taken are indecent. 

"Public Place" is not defined in legislation. A public place is usually where the public is 
allowed to have access freely and without payment or permission; this includes any public 
highway or footpath. The inside of a car is also considered a public place unless it is parked 
on private property. 

You may take photographs of people or objects (including buildings) whilst in a public place. 
With a few exceptions, the property owners cannot prevent you from doing so, and people 
cannot generally object to having their photographs taken. 

http://www.urban75.org/photos/photographers-rights-street-shooting.html
http://www.photographers-resource.co.uk/photography/legal/ukphotographersrights.pdf
http://www.photographers-resource.co.uk/photography/legal/ukphotographersrights.pdf
http://www.british-photographic-council.org/
http://www.thebppa.com/
http://en.wikipedia.org/wiki/Photography_and_the_law
https://phnat.org/
https://www.askthe.police.uk/content/Q717.htm?version=0
https://www.askthe.police.uk/content/Q717.htm?version=0


 

In the UK, you do not have to get permission from people you photograph whilst in a public 
place. Using and selling images of people in a public place is usually acceptable if used for 
any journalistic or artistic material. 

However, if you intend to sell the image commercially or use it for a commercial purpose 
(for example, to promote a product), getting people to sign a model release form is 
recommended. 

 
10.4 On Private Property 
If the person you're photographing is on private land, they could claim a right to privacy, and if 
you're on private land, then the owner of the land has the right to restrict photography on their 
property. 
 
How you choose to use the photos later may well be restricted by whether you have a model 
release or property release, but this is a different matter. 
 
If you are asked to stop taking photographs on private property, it is advisable to do so. The 
person asking might not have the legal right to do so, but the actual landowner will likely side 
with them rather than you. Additionally, you could be accused of trespass. 
 
Property owners or their employees and security staff have no right to confiscate, inspect or 
damage a photographer's camera or insist that images are deleted. 
 
Railways and tube stations generally allow people to take non-commercial photographs as long 
as they don't cause an obstruction (more likely to happen if you are using a tripod). However, 
asking station staff first is probably a good idea. 

 
10.5 Harassment and Invasion of Privacy 
 

It is illegal to harass another person, and taking photographs could amount to harassment; 
this isn't to say that someone could claim they were being harassed just because they were 
being photographed when they didn't want to be. Harassment is essentially behaviour that 
causes another person alarm or distress, and it refers to a course of conduct, not a single 
incident. (A "course of conduct" means at least two occasions.) If a photographer stalks a 
subject to get a photograph of them or repeatedly thrusts a camera in someone’s face, this 
might be harassment. 

The law is not the same throughout the UK. In England, Wales and Northern Ireland, 
harassment is a criminal offence, for which the penalty is up to 6 months in prison, or a fine, 
or both. A victim of harassment can also bring legal action for an injunction against the 
person harassing them and a claim for damages. Breaching the injunction is also a criminal 
offence. In Scotland, harassment itself is not a criminal offence, but the victim can ask the 
court for a "non-harassment order" against the person who is harassing them. Breach of the 
order is a criminal offence. 

 



 

10.6 Invasion of Privacy 
 
Invasion of privacy is a difficult thing to determine in UK law. The UK has never recognised a 
general right to privacy, but the European Convention on Human Rights gives everyone the 
right to respect his private and family life, home, and correspondence. 

It is not always easy for a photographer to know whether taking or publishing a photograph 
might amount to an invasion of privacy. 

Taking photographs of a person in a public place would not usually be regarded as an 
invasion of privacy. The key seems to be whether the site is where a person would have a 
reasonable expectation of privacy. Using a telephoto lens to take a photo of someone in a 
private place, in their home, for instance, without their consent, is probably an invasion of 
privacy even though the picture is taken from a public place. 

The lack of any coherent law of privacy in the UK means that photographers are not only 
free to take photographs of people in public places, but they can use those photos as they 
wish, including for commercial gain. In some countries, individuals have rights over the 
commercial use of their images, hence the importance of obtaining a model release to use 
an image that contains a recognisable person. 

UK law does not, at present, recognise this right. But failure to obtain a model release will 
seriously impair the commercial use of an image because most photo libraries, stock 
agencies, and the like have an international customer base and will not accept a picture of a 
recognisable person without a release. 

 
10.7 Data Protection Act 

There is also a possibility that photographs of people may be subject to the Data Protection 
Act, which controls the "processing" of "personal data", that is, data relating to an individual 
from which the individual can be identified. The definitions of these terms are complex, but 
taking a photograph of a recognisable person would appear to fit within them. The Act 
contains an exemption (section 32) which applies where you are "processing" personal data 
for journalistic or artistic purposes; you are doing so with a view to publication; and it would 
be incompatible with your journalistic or artistic purposes to be required to comply with the 
Act (for example, it would be incompatible if you had to put down your camera to ask 
consent of everyone captured in a street scene), much photography will probably be 
protected by this exception. 

 

 

11 Entries 

11.1 Photographs must be a minimum 3MB – maximum 50MB file. 

11.2 Image format guidelines 

 



 

 
 

Preparing a Digital Image 

 
 

Never reduce your master file to this size. 
Always keep your master the size it came out of your camera and therefore at the highest possible 
resolution. 
Once you are happy with your image, make a copy of it and use that version to produce your final 
jpg. This is in case you accidentally save the file when it is reduced. 
The following instructions are for Photoshop but the principle is the same for all photo editing 
applications and you can find many tutorials for them online if needed. 
 
1. To re-size your file, go to Image > Image Size. 
If your picture is Landcape (wider than it is tall) make the width 1400 pixels. 
If the height reads 1050 pixels or less the file is the correct size but if the height reads larger than 
1050 pixels, change the height to 1050 pixels which will reduce down the width and your image size 
will now be correct. 
If your image is Portrait (taller than it is wide) simply make the height 1050 pixels. Click OK. The 
Resolution size doesn’t matter with these images. 
 
2. To give your file the correct colour profile, go to Edit > Assign Profile. 
Choose sRGB IEC6 1966-2.1 and click OK. 
 
3. To make your jpg, go to File > Save As and choose the Format to be jpg Then Name the file as 
described above and Save. 
 
4. The JPG Options window will then appear, make sure the quality is 12 (maximum quality) and the 
Format Options is Baseline. Click OK and it’s all done! 



 

 
 

 
 



 

 
 

11.3 Video must be 5 minutes maximum duration an in HD  

11.4 Video format guidelines 

 



 

 

 

 

Codecs: H.264 / AAC 

 

A codec is the format in which your video should be encoded. Different codecs have different 
features and varying quality. For best results please use H.264 (sometimes referred to as 
MP4) for the video codec and AAC (short for Advanced Audio Codec) for the audio codec. 

Frame rate: 25 FPS 

 

If there is an option that says "current," it is best to just go with that. Otherwise, please go 
with 25 fps. If there is an option for keyframes, use the same value you used for framerate. 

Data rate: 5000 kbits/sec (HD) 

 

This setting controls both the visual quality of the video and how big the file will be. In 
most video editors, this is done in terms of kilobits per second (kbits/sec or kbps). Use 
5000 kbits/sec for high definition footage. 

Resolution: 1280x720 (HD) or 1920x1080 (HD) 

 

If you have the option to control the pixel aspect ratio (not display aspect ratio) make sure it's 
set to "1:1" or "1.00", also sometimes called "square pixels." 

Deinterlacing YES 

 

If you have this option, enable 

it. Audio 320 kbps / 44.100 kHz 

Choose AAC for the audio codec. Please set the bit rate to 320 kbps and the sample rate to 
44.100 kHz if possible. 

Format MP4 

 

Please submit your video as MP4 if at all possible. However, we can generally accept these 
formats: .mov, .mpeg4, .avi, .wmv. 



 

11.5 There is a maximum of 10 photographs per entrant & 1 video.  

11.6 An image/video will be rejected if it appears to have been taken in such a way that it 
may have been in breach of the law, privacy policies or others, or it has been otherwise 
taken irresponsibly. 

11.7 The following details must be submitted with each entry:  

1. Title of the photography and or video  

2. Short description of photography and or video and methods used in 
shooting/filming  

3. Name of author and contact details as in the application form 

4. Category: student, amateur, professional  

5. A statement that the material in the video does not violate any copyright 
or privacy protections 

The Chelmsford Fringe Festival reserves the right to remove or refuse any entries from the 
competition for any reason. 

12 Judging 
A panel of Judges will select images based upon technical skill, originality and creativity of 
composition. Judges will assess entries to establish winners and commended photographers/ 
filmmakers and collectively agree on the overall competition winner. Leading personalities of 
culture will constitute the panel: from the Essex and Chelmsford City Councils, Personalities 
related to the Film and Documentary programming at the Festival, representatives of the 
Partners and Marketing representatives of the Festival, including media and printing partners.  
 
Digital adjustments are acceptable; however, any digital enhancement or editing used will be 
taken into account when judging the entry.  Cropping is allowed. 
 
The organisers' decision is final, and no correspondence will be entered into concerning the 
competition’s judging and organisation. 
 

13 Announcement of winners 

The judges will choose the winner and commend photographers and filmmakers; all winning images 
and videos will be displayed online on a virtual gallery. All photos may be shared on the Chelmsford 
Fringe Festival social media and website. 

The overall winners will be announced in January 2022 following the competition call.  

14 Usage Rights 

By entering the competition, you grant the Chelmsford Fringe Festival a non-exclusive, irrevocable 
licence to reproduce, enlarge, publish or exhibit, on any media, the images and videos for any 
purpose to further its aims and objectives. More specifically to use: 



 

• At presentation events, including exhibiting the images and videos in an exhibition; 
marketing and promotion of the Chelmsford Fringe Festival; and email communications on 
the Chelmsford Fringe Festival website. 

• In the press, to publicise this photography and video competition and promote the 
Chelmsford Fringe Festival. 

• In conjunction with the sponsors, to further promote the Chelmsford Fringe Festival and this 
competition. 

The organisers will make every reasonable effort to ensure that name credits are given to any 
photograph and film published in any medium. 

15 Data Protection 

We will keep your details on our secure database to enable us to use your images (see usage rights) 
send you information about the annual photography competition and other information about the 
Chelmsford Fringe Festival prize. We value your support and do not pass on information about you 
to any group or individual outside the Chelmsford Fringe Festival Photography&Video Competition 

16 Indemnity and Limitation of Liability 

To the maximum extent permitted by law, the Chelmsford Fringe Festival excludes its liability for any 
loss, damage, injury, cost or expense suffered by you, whether directly or indirectly and howsoever 
caused, in connection with the competition and use of any prize. Nothing in these terms and 
conditions shall exclude the Chelmsford Fringe Festival liability for death or personal injury arising 
from the Chelmsford Fringe Festival own negligence or any other liability that cannot be excluded as 
a matter of law. 

You agree to indemnify the Chelmsford Fringe Festival against any loss, damage, injury, cost or 
expense suffered by the Chelmsford Fringe Festival as a result of your entry into the competition, 
including (but not limited to) any claim of infringement of intellectual property rights made by any 
third party. 

17 General 

The information given in these Terms & Conditions is correct, but the Chelmsford Fringe Festival 
reserves the right to change any of it without prior notice. By entering the competition, entrants will 
be deemed to have agreed to be bound by these Terms & Conditions. Any breach of these Terms by 
an entrant will void their entry. If a breach has occurred but is discovered after the award of a prize, 
the organisers may require the return of that prize. 

The Chelmsford Fringe Festival Web Privacy Policy applies to the competition and use of the 
Chelmsford Fringe Festival Competition on the website. 

You agree that if you are a winner or commended photographer or filmmaker, you will participate 
fully with reasonable publicity and use your name and photograph/video in such promotion. You will 
also agree to be present at the award ceremony for the year you have been awarded.  

These Terms and Conditions shall be governed and construed in accordance with English Law and 
will be subject to the exclusive jurisdiction of the English courts, in particular the Chelmsford Crown 
Court. 
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